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Opening WebCOR
Below is the Welcome Page that you will see when you open
WebCOR.

WebCOR

User's Guide | Report Problems

Welcome to COR - Carrier Optimal Routing
Carrier Optimal Routing (COR) is a computer modeling program that utilizes specifically designed
algorithms to configure compact contiguous carrier routes, determine safe and efficient lines of travel, and
to determine Park Points and Relays based on actual volume. The program makes objective decisions
based on data to reduce unnecessary travel, Park Points, Relays, and mileage. The benefits include
improved safety, and a reduction in fuel and energy. COR also provides accurate carrier route maps and
efficient lines of travel.
Important Information

Application Access
Enter Application

COR uses your ACE ID to authenticate. Any ACE USER authorized to use
COR will be able to access the COR web application. If you are not an Need approval to use this
application?
authorized user, please request access through eAccess.
Forgot Your Password?
Click Here to Reset it
Help
For questions and feedback, please contact your District or Area COR Coordinator. For technical help
with the COR application, call 1-800-877-7435.
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Chapter 1
Getting Started in WebCOR
Click Enter Application, and you are directed to the COR Log On screen. Enter your
Logon ID and Password, and click Log On.
The Zone Selection screen appears. Launch the application by first selecting a role or
utilizing the role for which you have been approved.

WebCOR Roles and Data Access
COR users are assigned one or more roles that determine what functionality is
accessible to them in the system.
If you are assigned the role of Data Preparation, you will have access to the data
preparation component of COR and in the Zone Selection screen, Data Preparation will
be the only option available.
If you are assigned the role of Route Adjustment, you will have access to the route
adjustment component, and Route Adjustment will be the only option in the Zone
Selection screen.
Some users may be assigned access to both Data Preparation and Route Adjustment. In
this case, a drop-down menu will appear in the Zone Selection screen to allow you to
choose one or the other. You cannot access both at the same time.
An additional Executive role provides some users read-only access to display routes for
zones that have been set up in COR.
Role
Data Preparation
Route Adjustment
Executive (Viewer)

Responsibilities and Privileges
Responsible for data preparation. Read / write privileges.
Responsible for route adjustment. Read / write privileges.
Utilized by Executives for viewing only. Read only privilege.
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Data Access Privileges
Data access privileges are user-specific and identify the data to which you have access,
based on geographic regions, typically defined by Districts or Areas.
Roles and Data Access privileges are determined by user ID in the USPS network. You
will only have access to zones that are within your assigned district or Area.

Understanding the Screen Display
The COR screen display consists of three main navigational elements: The
Toolbar, the Map, and the COR Menu Sidebar.
The Toolbar is positioned horizontally along the top of the COR application window and
provides a link to the Help Guide as well as to the Tools and Buttons for utilizing the
COR system.
The Map provides a graphic display of the geographic zone or display area.
The COR Menu Sidebar is positioned vertically on the left side of the application
window, and provides expandable menu items and procedures for interacting with the
map.

Using the COR Menu Sidebar
You can expand and collapse items in the COR Menu Sidebar menu items as needed.
Click the down arrow to expand a menu item, and click the up arrow to collapse it.
The content of the menu item is hidden but not deleted. Expand the menu item to see
the content again.
Some menu items may be moved around the window, collapsed, and closed. To make a
menu item moveable, click the right-facing double arrow , and the menu item appears
in its own pop-up window.
Click the gray arrows
sidebar.

in the upper right corner of the sidebar to expand or collapse the
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WebCOR Tools
Name

Zoom In

Zoom Out

Pan

Full Extent

Icon

Description
Click and drag a rectangle: Click and hold the left mouse button
down on the map. Drag the mouse to the other corner of the
rectangle, and release the mouse button. The map will zoom in to
the area of the rectangle. (Note: You must click and drag; simply
clicking on the map will not work).
Click and drag a rectangle: The map will zoom out so that the
current map area will fit into the rectangle. The smaller the
rectangle you draw, the more the map will zoom out. (Note: You
must click and drag; simply clicking on the map will not work).
Click and drag the map: Click and hold the left mouse button on
the map, and drag the map. The map is recentered, to the
location where you release the mouse button.
Full extent: Immediately zooms the map out to the full extent of
the area for all features and layers. The active tool does not
change.

Measure

Measure distance or area: The Measure function allows you to
measure a line or an area.

Extents
(Back)

Navigates the map back one view in the extent history for this
session.

Extents
(Forward)

Navigates the map forward one view in the extent history for this
session.

Print

Prints the map of the current zone. Click the icon with the left
mouse button.

Layer
Menu

Edit
Information
Tool
Change
Zone

All operations are performed in the Working Layer. The
Layer selected in the drop down menu is the Working Layer
and determines what operation is current. It also allows you
to edit on the current Working Layer. Map layers are Street,
Blockface, Delivery Location, or Post Office.
Click to edit info: Click with the left mouse button and edit the
information from the working layer that you select in the Layer
Menu. See below for more information on the Edit Info tool.
Click to return to the Zone Selection screen and select or extract
another zone.
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Edit Information
The Edit Information tool allows you to view and edit information in any layer (street,
delivery location, blockface, post office) in the current zone.
1. Select a layer from the Layer drop-down menu in the toolbar.
2. Click the Edit Information Tool

to select it.

3. With the Edit Info tool selected, click an object in the map layer. The Pop Up
Menu displays, showing the attributes for that object.
4. In the Pop Up Menu, view and edit information for the selected object. At the
bottom of the window, you must click Save to save your edits.
5. This tool replaces the former

tool from the COR Desktop software.

Using Tools
The Tool Icons in the toolbar allow you to interact with the map by clicking on the map
and performing that function with the selected tool. For example, if you click on the
Zoom In Tool
in the toolbar, then click and drag a rectangle in the map, the map will
zoom in around where you have drawn.
•

In the toolbar, click the tool you want to use.

•

Move the cursor over the map. The cursor changes into the tool you selected.

•

Click the map with the left mouse button. (Note: Some tools work by depressing
the mouse and dragging the cursor to draw a rectangle, line or polygon, then
releasing the mouse button.)

•

The results of your action depend on the tool you chose. The map appearance
may change, as with zooming in or out.

IMPORTANT: USING the WebCOR MANUAL
This manual was prepared with ease of use in mind. The menu selections and
application instructions have been simplified to ensure that they could easily be utilized
by all levels of COR users.
At the beginning of each new process listed in the manual, a “Menu Procedure” is
displayed to provide the correct menu selection for the user. An example of this is:
Zone Selection → Data Preparation → Extract Zone
Directly below the “Menu Procedure” is a brief explanation of the process that will
be executed in the COR software.
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Map Layers
Menu Procedure:
COR Menu Sidebar → Map Layers
The Map Layers menu item allows you to view all the contents contained in the current
map, turn on and off the view of map layers, and examine the symbols associated with
layers.

Examine the Map Layers
In the sidebar, click the down-arrow in the Map Layers menu item. The map layers of the
current zone appear below the menu item. Only the top-level content items are visible.
Click the plus button

next to a content item to display the layers within it.

Select or deselect the check-box next to the layer to toggle the layer's visibility. The
map automatically redraws to reflect the changes in layer visibility.
Some layers may not be visible at the current map scale (zoom level). These layers are
scale-dependent. You may need to zoom the map in or out to see a particular layer
displayed, even if its check-box is selected. Layers that are scale-dependent will appear
disabled in the Map Layers menu item, until you have zoomed to the scale at which they
may be displayed. For example, Streets and National Streets are disabled unless you
are zoomed out to a high elevation.
Streets are the streets within the zone and the buffer area that you extract; National
Streets are the streets outside of the area.
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DATBASE PREPARATION
Chapter 2

Extract Zone
Menu Procedure:
Zone Selection → Data Preparation → Extract Zone
When you log into COR, the Zone Selection screen displays (note: if you are logged in
with access to both Data Preparation and Route Adjustment, select Data Preparation
from the drop-down menu). For more information see Getting Started in COR.
In the Zone Selection screen, enter a five-digit ZIP code in the Zone field, and then click
Extract Zone. The Data Preparation—Extract Zone screen appears, and the streets
whose ZIP Code matches the zone you selected are highlighted in the map. The Extract
Zone pop-up window appears over the map.

Setting up the Zone
1. You will want to add additional streets to the zone as a buffer. Select the radio
button that says ‘add’ and include streets around the entire zone that represent a
buffer to that Zip Code. NOTE: If the delivery unit Post Office is not within
the zone you will need to include all streets that the carriers traverse to
reach the zone.
2. To add/remove areas of the zone, use either the Pointer Tool, the Rectangle, or
the Select by Shape tool to select the area you want to add or remove.
3. If after selecting areas in the map to add-to or remove from your zone, you
want to start over you can revert to your original selected zone by clicking
Reselect.
4. Once you have completed all edits, click Zoom to zoom in to the selected zone.
5. Click Extract to extract the zone.
6. A pop-up message will appear saying the zone has already been extracted. Click
OK to replace the original extraction.

13

COR DATABASE PREPARATION USERS MANUAL

This page intentionally left blank

14

COR DATABASE PREPARATION USERS MANUAL

Chapter 3
DOIS Import
Menu Procedure:
COR Menu Sidebar → Utilities → DOIS Import

The DOIS Import utility allows you to import the most current delivery addresses and
NDSS records directly from DOIS. COR and DOIS communicate and automatically
download the delivery address data and NDSS records for your zone. You will be
notified with a report that either indicates the transfer was successful or that the data
could not be transferred.

Importing from DOIS
1. In the COR Menu Sidebar, click Utilities to expand the menu items.
2. Click DOIS Import. The DOIS Import pop-up window appears over the Map
window.
3. Click Yes to perform the DOIS Import, and No to exit without importing DOIS data.
You will be advised whether your import was successful or not.
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Chapter 4
Understanding Topology
Menu Procedure:
COR Menu Sidebar → Map Layers → Network Layers → Street Topology
Understanding the concept of Topology is one of the most important skills for
successfully completing COR Databases. For the purposes of COR, topology refers to
the way that the graphic database was originally digitized or drawn. It is not related to
the carrier’s Line of Travel or to One Way streets. Instead, it refers to the way the
streets were drawn by the individual who originally created the graphic database.
When a street is drawn, the person creating the database draws the street from one
Node to another Node. As the line is created, the direction that the street is drawn to
and from indicates which side of the street is the left and which side of the street is the
right.
A simple method for understanding this concept is to picture someone being instructed
to draw a line being between two dots on a piece of paper. The dot, or point, where the
person begins drawing the line is the “From” point and the point that it is being drawn to
is the “To” point. As the line is drawn, one side is the Right side and one side is the Left
side. By placing arrows on the line in the direction that it is being drawn, the Left and
Right sides become even more identifiable. That is how Topology is indicated.
In WebCOR, displaying the topology is accomplished by using the down arrow in the
Map Layers section and clicking the Plus (+) sign next to Network Layers. Place a check
mark in the box next to Street Topology and the topology for the zone will be
displayed on the map. Arrows showing in what direction the streets were drawn for the
zone database appear on all streets and blockfaces. These arrows display which side of
the street is the Right side and which side is the Left side by viewing the direction in
which the arrows are pointing. By displaying the Nodes for each blockface, you can also
determine the Begin Right, Begin Left, End Right and End Left for each blockface.
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Chapter 5
Delivery Location Procedures
Open Alternate Address Table (AAT)
Menu Procedure:
COR Menu Sidebar → Delivery Location Procedures → Open Alternate
Address Table
An Alternate Address Table (AAT) is a database table with an entry for every delivery
address. This table allows you to indicate the actual physical delivery location for each
delivery address as well as the assigned municipal address.
Some deliveries are made at CBUs or other Central Delivery locations such as
apartment complexes. Since the location of the CBU, NDCBU, or other Central Delivery
location is not the actual physical location of the delivery point address, the AAT allows
you to route delivery service to the location on the map where the actual delivery takes
place.

Setting up the Alternate Address Table (AAT)
In the COR Menu Sidebar, click Delivery Location Procedures to expand the menu item.
Then click Open Alternate Address Table. The Alternate Address Table pop-up window
displays.
The Alternate Address Table provides you with the following information for each
address: the existing route for which the address is currently assigned to in the zone, the
delivery sequence number, the Plus4 code, the delivery type, the street number, the
address type, the Apt/Suite number, the street name, the delivery location number, and
the delivery location street The CBU, BLDG, or group ID is also included and in addition
it will be in notes: whether the address was modified, the model route number, the model
sequence, the delivery location ID, and the No Stat Default indicator.

Edit Alternate Address Table
Columns with editable information in the AAT have a white background; all other
columns are read-only with gray backgrounds. The columns that may be edited are:
¾ Delivery Location Number
¾ Delivery Location Street
¾ CBU BLDG
These are the fields that allow you to create alternate addresses. To make changes to
one of these for a selected delivery address, click the field in the appropriate column,
and make the changes as needed. These line item edits are particularly useful when
delivery occurs on the opposite side of the street.
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Edit CBUs, NDCBUs, & Other Types of Central Delivery
As you scroll down through the AAT, you will see in the CBU BLDG field some entries
with C and some with numbers. The C is an indication that the delivery point is part of a
CBU or NDCBU and must have further information entered.
The entries with numbers are Central Delivery (such as apartment complexes) where
the building number is the same for all the addresses and the actual deliveries are all at
one location. For these central boxes, COR determines a unique BLDG value. This will
ensure that all these deliveries are represented by a single delivery location.
For the CBU or NDCBU values, you must determine which addresses belong together in
the same CBU or NDCBU and at what address the CBU or NDCBU is physically located.
When manually editing the CBU/BLDG field you must use a leading C to depict a CBU or
NDCBU or a number to indicate a bldg number. This field cannot include any leading
zeros. Note: The delivery unit can assist in providing CBU or NDCBU diagrams for these
delivery addresses to determine their actual delivery locations.
1. Locate the addresses in the AAT that belong in the same CBU or NDCBU.
2. Click and hold the left mouse button in the Del Loc Number field of the first
address that belongs in the CBU or NDCBU.
3. Drag the cursor over the Del Loc Street and CBU BLDG fields, and down until you
reach the last address that belongs in the CBU.
4. Release the mouse button. The three fields for the addresses that belong in the
CBU or NDCBU are highlighted.
5. Edit AAT fields appear at the bottom of the AAT, for changing the delivery
location number, delivery location street, and CBU BLDG.
6. Click Next CBU # or Next BLDG # and COR sets the next available CBU value or
BLDG value.
Click OK, and each highlighted delivery record will have an alternate address matching
what you typed in and a CBU BLDG value as determined by COR. You can edit the CBU
BLDG value. However, you do not want to reuse a value that is already in use and you
must keep the same value for all deliveries in the same CBU.
Use the same process for grouping Central Delivery addresses. Note: If a CBU is
located in a parking lot area that is not represented by a street in your street database,
you can add a new street using Edit Streets. The new street that you add must be given
a street name and address range that is different from the actual street. Then, you may
use an alternate address for the CBU that will cause it to be located on the new street
that represents the parking area. You may not know this until after the street validation
has been performed. If you know this now, you can add the new street. If you do not
learn this until after street validation, the new street can be added at the time you are
making other modifications based on the results of your street validation. (See Adding a
Street).
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Chapter 6
Selection Tools
Menu Procedure:
COR Menu Sidebar → Utilities → Selection Tools
Selection tools allow you to select streets and delivery locations in the corresponding
layers. Once a street is selected, you can edit the selection in the Street Table.
However, delivery locations are not editable.
Also, you may use the Selection Tools to zoom to a selected street, by using Field,
Operator and Value.

Select Streets or Delivery Locations Using Tools
1. In the COR Menu Sidebar, click Utilities to expand the menu item.
2. Click Selection Tools. The Selection Tools pop-up window appears over the map.
3. In the Selection Tools pop-up window, choose Street or Delivery Location from
the Layer drop-down menu.
4. You may create a new selection, add to an existing selection, or remove a
selection, by choosing the New, Add, or Remove radio button, and using either
the Select by Pointing, Select by Rectangle, or Select by Shape tool.
5. To create a new selection, choose the New radio button, and then choose one of
the selection tools with which to select an area of the current zone.
6. Once a street or delivery location is selected, you may add to the selection by
choosing the Add radio button, and then using a tool to add to the selection.
7. You may remove selected streets or delivery locations by choosing the Remove
radio button, and then using a tool to remove streets or delivery locations from the
selection.

Select Streets or Delivery Locations Using Field,
Operator, Value
1. You may select a street or delivery location by choosing a field object from the
Field drop-down menu and an operator from the Operator drop-down menu, and
entering a value in the Value field.
2. For example, with Streets selected in the Layer drop-down menu, in the Field
drop-down menu, choose Street Name. In the Operator drop down menu, choose
Contains. In the Value field, enter Park, and click Select. All streets with names
that contain Park are selected in the current zone.
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Clear, Zoom, and Toggle
¾

Click Clear to clear the selection from the current zone.

¾

Click Zoom to zoom in on a selection.

¾

Click Toggle to reverse the selection; that is, if a specific street is selected and
you click Toggle, the street is deselected and all other streets in the zone are
selected.
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Chapter 7
Address Match Delivery Locations
Menu Procedure:
COR Menu Sidebar→ Delivery Location Procedures→ Address Match
Delivery Locations
Address Match Delivery Locations combines the individual addresses into delivery
locations, and adds a point to the map for every delivery location whose corresponding
street is located in the current zone. For a delivery location to be address matched, a
street with the same ZIP Code and street name must exist in the zone. Also, the street
must contain an address range that includes the delivery location’s street number.

Setting up the Address Match Delivery Locations
Procedure
1. In the COR Menu Sidebar, click Delivery Location Procedures to expand the
menu item.
2. Click Address Match Delivery Locations. The Address Match Delivery Locations
pop-up window appears over the map, and displays the number of matched and
unmatched delivery locations.
3. Click Match, and COR automatically attempts to match the unmatched delivery
locations in the current zone, and the Delivery Location Layer is visible in the
map.
The Delivery Location Table will have a record for every delivery location that is
successfully matched. Unmatched delivery locations are found in a table of unmatched
delivery locations, in the Delivery Location Toolbox. To view the unmatched records,
you will need to open the Delivery Location Toolbox. Go to the COR Menu Sidebar, click
on the down arrow for Delivery Location Procedures, and select Delivery Location
Toolbox. A list of the unmatched records will appear. You will need to print this list of
unmatched records by clicking on the print button at the bottom of the pop-up window.
Procedures to resolve unmatched deliveries are listed below.

Resolving Unmatched Delivery Locations
Deliveries might not match for a number of reasons. For example; the address was not
located in any of the existing address ranges or the address exists in more than one
address range. Another reason for unmatched deliveries could be that the street is not
correctly spelled or does not exist in the current zone. This could also occur if no street
name exists that matches the unmatched deliveries or if a street name is misspelled.
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The following information lists the most likely reasons that Deliveries are unmatched:
¾
¾
¾
¾
¾

Incorrect Zip Codes on the Streets
Incorrect or Missing Address Ranges on the Streets
Overlapping Address Ranges on the Streets
Missing or Incorrect Street Names
Missing Streets

The Existing Sequence listed in the Delivery Location Toolbox can be of assistance in
locating where a delivery belongs. Deliveries just before or after the unmatched record
may be located on the map and may also provide information to assist in matching the
deliveries.
To utilize the Existing Sequence process to assist in resolving unmatched deliveries,
follow these procedures: Go to the COR Menu Sidebar, click on the down arrow of the
Delivery Location Procedures, and select Delivery Location Toolbox. When the popup
menu appears, click in the box next to Label and a check mark will appear. In the box
directly to the right of Label, choose Existing Sequence by clicking on the down arrow
and highlighting Existing Sequence. Labels for the Existing Sequence of the route
deliveries will appear. This process will assist you in locating any unmatched deliveries.
Below is a brief explanation for each of the above problems and information on how they
can be resolved:
Menu Procedure:
COR Menu Sidebar → Street and Office Layer Procedures → Open Street
Table

Incorrect Zip Codes on Streets
In the Delivery Location Toolbox Unmatched Record List, view the Zip Codes for all of
the unmatched records. Go to the Street Table and open it. Select those records that
had Zip Codes that did not match the Zip Code for the Zone that you are currently
working on. Click on the records that you want to resolve by making a Check Mark next
to the Record. Change from All Records to Selected Records and Click on the Edit
Selected button and those records that you selected will appear. This will activate the
Field and Value options in the table below. All the records that appear can be changed
by typing the correct information in that table. Click on the OK and the changes will be
made. Once you have resolved all of the Unmatched Records, Re-Address Match by
following the Address Matching procedure.

Incorrect or Missing Address Ranges on the Street
In the Delivery Location Toolbox Unmatched Record List, view all of the unmatched
records. Review records that have a street name that matches any of the unmatched
records. Go to the Street Table and open it. Select those records with matching street
names that have address ranges that encompass the house numbers of the delivery
locations that you are trying to match. If none encompass the correct address range
then either the necessary block of the street is missing or a particular segment of the
24

COR DATABASE PREPARATION USERS MANUAL

street has wrong or missing address range information. Once you have determined the
problem, Click on the records that you want to resolve by making a Check Mark next to
the Record. Change from All Records to Selected Records and Click on the Edit
Selected button and those records that you selected will appear. This will activate the
Field and Value options in the table below. All the records that appear can be changed
by typing the correct information in that table but the address ranges will probably have
to be selected one at a time for the corrections. Click on the OK button and the changes
will be made. Once you have resolved all of the Unmatched Records, Re-Address
Match by following the Address Matching procedure.

Overlapping Ranges on the Streets
In the Delivery Location Toolbox Unmatched Record List, view all of the unmatched
records. Review records that have a street name that matches any of the unmatched
records. Go to the Street Table and open it. Select those records with matching street
names that have address ranges that encompass the house numbers of the delivery
locations that you are trying to match. Click on the records that you want to resolve by
making a Check Mark next to the Record. Change from All Records to Selected
Records and Click on the Edit Selected button and those records that you selected will
appear. This will activate the Field and Value options in the table below. All the records
that appear can be changed by typing the correct information in that table but the
address ranges will probably have to be selected one at a time for the corrections. Click
on the OK button and the changes will be made. Once you have resolved all of the
Unmatched Records, Re-Address Match by following the Address Matching procedure.

Missing or Incorrect Street Names
In the Delivery Location Toolbox Unmatched Record List, view all of the unmatched
records. Review records that have a street name that matches or is similar to any of the
unmatched records. Go to the Street Table and open it. Select those records with
matching or similar street names of the delivery locations that you are trying to match.
Click on the records that you want to resolve by making a Check Mark next to the
Record. Change from All Records to Selected Records and Click on the Edit Selected
button and those records that you selected will appear. This will activate the Field and
Value options in the table below. All the records that appear can be changed by typing
the correct information in that table but the address ranges will probably have to be
selected one at a time for the corrections. Click on the OK button and the changes will
be made. Once you have resolved all of the Unmatched Records, Re-Address Match by
following the Address Matching procedures.
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Missing Streets
Missing Streets requires a new additional skill set. Below is an explanation of the
process and the necessary tools:

Edit Selected Streets
You may edit street attributes of selected streets in the Street Table.

Edit Streets
Menu Procedure:
COR Menu Sidebar → Utilities → Edit Streets
Edit Streets allows you to add a street, split a street, or modify the geography of a street,
so that you may resolve unmatched delivery locations.

Split Streets
1. In the sidebar, click Utilities to expand the menu item.
2. Click Edit Streets. The Edit Streets pop-up window appears over the map.
Important: Select CorWorkspaceEdit: SDE DEFAULT from the drop-down menu
under Select a version ID. Click on the Start Editing button to expand the Edit
Streets window.
3. Using the select street tool in the Edit Streets window, (
), select the street
you wish to edit. Once your street has been selected, the attribute section of the
window will appear.
4. Activate the split feature tool, (
), it the Edit Streets window. Click on the
selected street where you want the split to occur. After splitting the street you will
need to edit the attributes for both sections of the split street. You may toggle
between selected segments of the street using the arrows shown underneath the
‘Edit Street Attributes’ section of the Edit Streets window.
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5. Ensure your topology is visible by clicking on the + sign next to the Network
Layers section in the Map Layers section of the side bar. Click in the box next to
the street topology option.
6. Edit the Start Left > End Left > Start Right > End Right fields of the street
attributes and click on the save edits icon in the Edit Streets window.

Create Streets
1. In the sidebar, click Utilities to expand the menu item.
2. Click Edit Streets. The Edit Streets pop-up window appears over the map.
Important: Select CorWorkspaceEdit: SDE DEFAULT from the drop-down menu
under Select a version ID. Click on the Start Editing button to expand the Edit
Streets window.
3. Click Settings in the lower right of the Edit Streets window, and the Settings popup window displays. In the Settings pop-up window, you must deselect the Vertex
and Edge check boxes in the Street Layer, as they are not necessary for the Edit
Streets tool. Leave End selected.
4. You may adjust the Snapping Tolerance, and Tolerance and change the
Selection Color, in the Settings window. After you have made your adjustments,
click Apply, and close the Settings window.
5. In the Edit Streets window, click the Add Line tool
. With the Add Line tool
selected, move the cursor over the end of a street and it turns into a target to
indicate that you may snap to the street. Click once on the end of the street.
6. Move the cursor in the direction you want the new street to extend. Click once to
create a vertex (turn) and double-click to end the street.
7. After double-clicking to end the street, go to the Edit Streets window, and enter a
name for the street you just created, in the Street Name field.
8. Click the Save Edit icon
widow.

. The new street you created appears in the Map

Modify Street Geography
1. In the sidebar, click Utilities to expand the menu item.
2. Click Edit Streets. The Edit Streets pop-up window appears over the map.
Important: Select CorWorkspaceEdit: SDE DEFAULT from the drop-down menu
under Select a version ID. Click on the Start Editing button to expand the Edit
Streets window.
3. Using the select street tool in the Edit Streets window, (
), select the street
you wish to modify. Once your street has been selected, the attribute section of
the window will appear.
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4. In the Edit Streets window, click the Show Vertices tool, (
), to display
the vertices on the street you wish to modify. The three Vertices tools will be

activated.

Add Vertex ,

Delete Vertex, and

Move Vertex.
5. Vertices may be added, deleted, or moved to change the shape of the street you
wish to modify. To change the length of the street, click the Move Vertex tool to
activate the tool then click the vertex you want to move. After clicking, a line
follows the cursor, indicating the move action. Click the new location for the
vertex.
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Street Editing Tools
Name
Select
Feature
Clear
Feature(s)
Show
Vertices
Undo
Redo
Save
Edit(s)
Discard
Edit(s)
Add Line
Split
feature
Merge
features
Delete
feature

Add vertex

Icon

Description
With the Select Feature tool selected, single-click an area or click or click
and drag a rectangle on the map. Selection is shown with a cyan (bluegreen) color (see Settings to change selection color). Features must be
selected before they can be modified or deleted.
Clears any selected features so that no features are selected.
If feature(s) are selected, displays their vertices in red. Vertices are the
points that define the shape of a feature.
Reverses the last editing operation. If pressed again, works its way
backward to undo actions done. Once you Save your work, you cannot undo
operations done prior to the save.
After an Undo, reinstates the action that had been reversed.
Saves all changes to the data in the edit session. You must Save before
exiting the browser in order to preserve your changes to the data.
Discard all changes to the data in the edit session.
Use to create a street. Click once at each vertex (point), and double-click at
the last vertex.
Splits a selected feature into two features. Select the tool, then click once at
the location to split the line. Each feature takes the attributes of the existing
feature.
Merges two or more selected lines into a single feature.
Deletes the entire point, line or polygon feature(s) that are selected. No
warning message is shown, but you can use the Undo button to undo the
delete.
For a line or polygon, adds a vertex along the edge where you click.

Delete
vertex

Deletes the vertex on which you click. You cannot delete the last two
vertices of a line.

Move
vertex

Moves a vertex. First, click the vertex you want to move. After clicking, a line
follows the cursor, indicating the move action. Click the new location for the
vertex.
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Chapter 8
Open Delivery Location Table
Menu Procedure:
COR Menu Sidebar → Delivery Location Procedures → Open Delivery
Location Table
A Delivery Location Table is a table that has one unique record for every physical
delivery location that has been successfully address-matched. For example, for every
entry in the AAT that has the same CBU BLDG value, a single record is created in the
Delivery Location Table. This represents the one location where the letter carrier will
deliver the mail to all of the delivery points associated with that one location.

Procedures for Opening Delivery Location Table
In the COR Menu Sidebar, click Delivery Location Procedures to expand the menu item.
Click Open Delivery Location Table. The Delivery Location Table displays.
The Delivery Location Table displays data on delivery locations within the current zone.
The default table is sorted in ascending order by Delivery ID. You may re-sort the table
by any of the categories in the column headers, in ascending or descending order, by
clicking the column header.
Select the check box in the Select column to select a delivery location in the map. In the
View drop-down menu, choose either All Records, or Selected Records to change the
view of the records in the Delivery Location Table.

Delivery Location Toolbox
Menu Procedure:
COR Menu Sidebar → Delivery Location Procedures → Delivery Location
Toolbox
In addition to editing the Street Table and Alternate Address Table, there are manual
tools available to locate delivery locations on the map. The Match Delivery Location tool
allows you to manually move a delivery location that you otherwise could not address
match. NOTE: The Match Delivery Location tool should only be used when no
other resolution can be made.
The Move Delivery Location tool allows you to relocate a delivery location that has
already been address matched. The Unmatch Delivery Location tool allows you to
unmatch a delivery location.
Select the Label check box and choose either House Number or Existing Sequence from
the Label drop-down menu, to view the house numbers or sequence numbers for
delivery addresses in the map of the current zone.
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Match an Unmatched Delivery Location
1. In the sidebar, click Delivery Location Procedures to expand the menu item.
2. Click Delivery Location Toolbox. The Delivery Location Toolbox appears over the
map.
3. Click the Match Delivery Location tool

.

4. The Delivery Location Toolbox displays a summary table of unmatched delivery
locations.
5. Select an unmatched delivery location in the summary table by single-clicking on
it. You may locate the delivery location in the map using Selection Tools (Sidebar
→ Utilities → Selection Tools).
6. With the unmatched delivery location selected in the summary table, click the
location in the map where the delivery location belongs.
7. Now click the street on which you placed the delivery location. The unmatched
delivery location is matched to the location you selected.

Move a Delivery Location
1. Select the Move Delivery Location tool
in the Delivery Location Toolbox, and
click the delivery location you wish to move. You may locate the delivery location
in the map using Selection Tools (Sidebar → Utilities → Selection Tools).
2. Click the new location in the map, where you want the delivery location to go.
3. Click the street associated with the new location. The delivery location is moved
to the new place you selected.

Unmatch a Delivery Location
1. Select the Unmatch Delivery Location tool

in the Delivery Location toolbox.

2. In the map, click the delivery location you wish to unmatch.
3. The delivery location is removed from the map.
After you match or unmatch a delivery location, the number of Unmatched Delivery
Location records showing at the bottom of the Delivery Location Toolbox is modified to
reflect the change.

32

COR DATABASE PREPARATION USERS MANUAL

Chapter 9
Street and Office Layer Procedures
Open Street Table
Menu Procedure:
COR Menu Sidebar → Street and Office Procedures → Open Street Table
The Street Table provides an editable summary table of all the data in the Street layer of
the current zone. Use the Street Table to select streets and edit street attributes, and to
resolve streets with incorrect ZIP Codes, incorrect or missing address ranges, and
overlapping address ranges as well as incorrect street names and route codes, and
route tag errors.

Procedures for Opening the Street Table
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Open Street Table. The Street Table displays over the map.
3. In the Street Table, all white fields are editable and all gray fields are not. You can
sort the data in the table by clicking any column header. Click the header a
second time to reverse the sort-order (Ascending and Descending).

Selecting Streets in the Street Table
To select streets in the Street Table, simply select the corresponding check box for the
street, in the leftmost column of the table. The street is highlighted in the map of the
current zone. NOTE: Ctrl + F can be used as a find tool to locate records in the Street
Table.

Edit Selected Streets
You may edit street attributes of selected streets in the Street Table. Editing street
attributes in the Street Table is especially useful for batch edits, as well as editing data
for a single record. (A Batch Edit is one where the data for a number of records can
be corrected with identical data simultaneously).
1. Select the check box in the leftmost column of the table, for the streets you wish
to edit. You may choose Selected Records from the View drop-down menu, to
view only the records you selected.
2. Click Edit Selected. In the lower part of the Street Table window, the Attributes
drop-down menu, Value field, and Apply and Cancel buttons appear
3. Make a selection from the Attributes drop down menu. For example, you may
want to batch edit an incorrect street name. Select Street Name, then in the Value
field, enter the new or corrected name for the streets you selected.
4. Click Apply. The selected streets in the Street Table are updated to reflect the
edits, and the changes appear on the map.
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Street Attribute Defaults
Menu Procedure:
COR Menu Sidebar → Street and Office Procedures → Street Attribute
Defaults
The default street attribute information must be applied to the Streets layer in order to set
each street segment’s average driving time, street crossing difficulty, and parking
restrictions. Apply the default street attributes prior to making specific changes for
particular street segments.
The Street Attribute Defaults pop-up window contains five columns: Class, Occurrence,
Drive Rate (MPH), Crossing Difficulty, and No Parking.
Class tells you the NAVTEQ Class of the street, the definitions of which are in Street
Class Definitions.
Occurrence tells you the number of times that a particular class of streets occurs in the
current zone.
Drive Rate in MPH represents an average speed for driving on this class of streets. The
Drive Rate should be set to 5 to 10 miles per hour below the posted speed limit to allow
for traffic and required stops. The speed is not the speed limit but instead is the average
achievable speed that the vehicle is able to travel on these class of streets within the
zone during the window of operations.
The Crossing Difficulty value is the relative difficulty of walking across a street of this
type with 1 being easiest and 5 being restricted. Crossing Difficulty should indicate the
complexity or danger involved in walking across a street of the particular class.
Parking restrictions should be set to either Yes or No, with Yes indicating that parking is
allowed, and No indicating that parking is not allowed.

Edit Street Attribute Defaults
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Street Attribute Defaults. The Street Attribute Defaults pop-up window
appears over the Map window.
3. In the Drive Rate (MPH), Crossing Difficulty, and Parking columns, enter new
default values in the fields for street classes.
4. Click Save. Your changes are saved and the Street Attribute Defaults pop-up
window closes.

Apply Street Attribute Defaults
Once you have edited the default street attributes, click Apply, and the values you set
are applied to the street layer in the current zone.
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Edit Turn Defaults
Menu Procedure:
COR Menu Sidebar → Street and Office Procedures → Edit Turn Defaults
The driving portion of the line of travel follows the path with the least amount of traveling
time. However, in order to discourage less desirable turns (left and U-turns), a time
penalty can be added for each turn made in the path. The end result can be to reduce
the number of left and U-turns used in forming the line of travel.
The turn defaults are not amounts of time literally added into the total route time. They
cause the lines of travel to consider driving differently to avoid certain types of movement
through an intersection. For example, a U-turn penalty of 60 seconds should be
interpreted as being willing to travel 60 seconds out of the way to avoid making the Uturn. Turn defaults are relative to each other. A 60 second penalty for making a U-turn at
an intersection is four times less preferred than a 15 second penalty for moving straight
through and intersection.

Procedure to Edit Turn Defaults
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Edit Turn Defaults. The Edit Turn Defaults pop-up window appears over the
Map window.
3. In the Edit Turn Defaults pop-up window, edit the penalty values in seconds in the
Right Turn, Straight Through, Left Turn, and U-Turn fields (Note: While these
penalties can affect the actual path that the line of travel follows, the penalty time
is not added to the travel time.)
4. Click Save to exit the window.
NOTE: The recommended Values for Turn Defaults are:
TURNS:
Right Turn
Straight
Left Turn
U-Turn

RECOMMENDED PENALTY VALUE:
0 Seconds
15 Seconds
30 Seconds
60 Seconds

These recommendations should be used for every zone unless there is a
compelling reason not to utilize them.
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Edit Network Attributes
Menu Procedure:
COR Menu Sidebar → Street and Office Procedures → Edit Network
Attributes
The Edit Network Attributes window allows you to make changes to turn exceptions,
one-way streets, and overpasses in the current zone.

Turn Exceptions
The driving portion of the line of travel follows the path with the least amount of traveling
time. In order to discourage specific turns, a time penalty can be added for any turn that
is prohibited or difficult. However, turn exception information may not be available during
data preparation. The COR route adjustment user may have to enter turn exceptions;
this section is provided if turn exception information is available for you to enter.
Note: To view turn exceptions, go to Map Layers and make sure the check box next to
Turn Exception is selected (Sidebar → Map Layers → Network Layers → Turn
Exception). You may already have some turn exceptions provided with NAVTEQ street
data. These will be visible when you turn on Turn Exception in Map Layers.

Add Turn Exceptions
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Edit Network Attributes. The Edit Network Attributes window appears over
the Map window.
3. To add a turn exception, select Turn Exceptions from the Layer drop-down menu.
4. Select a penalty value for the turn from the Penalty Value drop-down menu.
5. Select the Add tool
, and click in the map on the street from which the turn will
be made. A blue line highlights the street.
6. With the Add Turn Exceptions tool still selected, click the street onto which the
turn will be made. The turn exception appears on the map as a line and
arrowhead, with the penalty value in the middle of the line.
7. To add a U-turn, click in the street on which the U-turn will be made.
8. Click again in the same street, then click in the intersection in which the U-turn will
be made.

Remove Turn Exceptions
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Edit Network Attributes. The Edit Network Attributes window appears over
the Map window.
3. To remove a turn exception, select Turn Exceptions from the Layer drop-down
menu.
4. To remove the turn exception, select the Remove tool
exception.
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Overpasses
The driving portions of the line of travel must adhere to geographic differences in street
elevation that make turns impossible from one street to another. To differentiate between
normal intersections where turns are possible, and intersections where there is an
overpass or underpass, use the Overpass tool in Edit Network Attributes. (Note: The
COR route adjustment user may have to enter edit overpasses; this section is provided if
overpass information is available for you to enter.)

Add Overpasses
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Edit Network Attributes. The Edit Network Attributes window appears over
the Map window.
3. To add an overpass, select Overpass from the Layer drop-down menu.
4. Select a value of 1 to add an overpass, and -1 to add an underpass (the default
value of streets in the zone is 0; you may add 2 or -2 for overpasses and
underpasses with more than one level).
5. Select the Add tool
, and click the street on which the overpass belongs, on
one side of the intersection. The number 1 is added to the map.
6. Click the street on the other side of the intersection, and a second 1 is added to
the map, indicating that the street you selected is elevated over the cross street
and no turns can be from it at the intersection.

Remove Overpasses
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Edit Network Attributes. The Edit Network Attributes window appears over
the Map window.
3. To remove an overpass, select Overpass from the Layer drop-down menu.
4. To remove the overpass, select the Remove tool
either side of the intersection.

and click the numbers on

One-Way Streets
The driving portions of the line of travel need to respect one-way street restrictions. In
COR the Street layer stores the one-way restriction information. You are able to edit
one-way streets in the Street and Office Layer Procedures section of COR Data
Preparation.
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Edit One-Way Streets
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Edit Network Attributes. The Edit Network Attributes window appears over
the Map window.
3. To edit a one-way street, select One-way from the Layer drop-down menu.
4. One-way streets in the current zone appear in the map highlighted by a blue line
and black arrowheads, pointing in the direction of the one-way street as it is
stored in the Street layer (Note: It may be necessary to zoom in to see the
displayed one-way streets).
5. Select the Add tool
. Click once on a section of the highlighted one-way street.
The highlighted blue line and arrowheads disappear, and the street is changed
into a two-way street.
6. Click in the same section of the street a second time, and the highlight blue line
and arrowheads reappear, pointed in the opposite direction. The direction of the
one-way street has been changed. If you click a third time, the street is restored
to its original direction.
7. You may click a two way street to change it to a one-way street, using the same
method.

Build Travel Network
Menu Procedure:
COR Menu Sidebar → Street and Office Procedures → Build Travel Network
The travel network represents a snap shot of how the streets are connected, the driving
and walking travel speeds, parking restrictions, and street crossing penalties. The travel
network is needed for Route Adjustment route generation and line of travel. It is
important to build the travel network during data preparation in order to check that the
streets are properly connected.

Building a Travel Network
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Build Travel Network. The Build Travel Network pop-up window appears
over the Map window.
3. The Build Travel Network window displays information on when the travel network
was last built.
4. Click Yes to build the travel network, or No to exit without building it.
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If areas of the travel network are disconnected, the Display Network Disconnects pop-up
window appears. Select the type of network disconnects to display, and click OK.
Note: There is only one travel network maintained at a time for a zone. Therefore, there
is no requirement for naming the travel network.

Display Network Disconnects
Menu Procedure:
COR Menu Sidebar → Street and Office Procedures → Display Network
Disconnects
It is important to build the travel network during data preparation in order to check that
the streets are properly connected. Once you have built your travel network, utilize
Display Network Disconnects to view areas of your network that are not connected in the
current zone.

Procedure to Display Network Disconnects
1. In the sidebar, click Street and Office Procedures to expand the menu item.
2. Click Display Network Disconnects. The Network Disconnects pop-up window
appears.
3. Select the type of network disconnect you want to display. Click OK. The map of
the current zone displays the disconnected areas of your network with a
highlighted color line.
Note: To view network disconnects, be sure that Disconnect Layers is selected in Map
Layers (Sidebar → Map Layers→ Disconnect Layers).
NOTE: All Network Disconnectivities must be resolved before proceeding. Utilize
the Street Editing tools to resolve all occurrences before continuing.
4. Disconnects can also be viewed from the street table window. In the sidebar,
click Street and Office Procedures to expand the menu item.
5. Click Open Street Table. The Street Table window opens. Scroll to the far right
of the Street Table window to view the three disconnect columns. Disconnect
Geographic, Disconnect One-Way, and Disconnect Self-Loop. Once the streets
within the zone that have disconnect have been identified and selected in the
Street Table, the selection tool can be used to zoom to the selected streets.

39

COR DATABASE PREPARATION USERS MANUAL

This page intentionally left blank

40

COR DATABASE PREPARATION USERS MANUAL

Chapter 10
Post Office Toolbox
Menu Procedure:
COR Menu Sidebar → Street and Office Procedures → Post Office Toolbox
A Post Office identifies where on the map the line of travel for each route starts and
ends. Find the address of the post office you want to add, and where on the map it
belongs.
Note: To view post offices in the map of the current zone, click Map Layers in the
sidebar, and make sure the check box next to the Post Office layer is selected under
Cosmetic Layers (COR Menu Sidebar → Map Layers → Cosmetic Layers → Post
Office).

Add a Post Office
1. In the Data Preparation sidebar, click Street and Office Procedures to expand the
menu item.
2. Click Post Office Toolbox. The Post Office Toolbox pop-up window appears over
the Map window.
3. To add a post office, select the Add Post Office tool
you want to add the post office.

and click the map where

4. With the Add Post Office tool selected, click the street on which the new post
office is located. The Attribute Page pop-up window displays.
5. In the Attribute window, enter a name in the Facility Name field, and click Save.
The new post office is added to the current zone.

Delete a Post Office
1. In the Data Preparation sidebar, click Street and Office Procedures to expand the
menu item.
2. Click Post Office Toolbox. The Post Office Toolbox pop-up window appears over
the Map window.
3. To delete a post office, select the Delete Post Office tool
and click the post
office you want to delete. The post office is deleted from the current zone.
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Chapter 11
Utilities
Blockface Toolbox
Menu Procedure:
COR Menu Sidebar → Utilities → Blockface Toolbox
All route adjustment is done by side of the street, or blockface. You can create a
blockface layer that defines the left and right side of each street segment. Be sure to
have the Blockface layer visibility selected in Map Layers.

Create the Blockface Layer
1.
2.
3.
4.

In the sidebar, click Utilities to expand the menu item.
Click Blockface Toolbox. The Blockface Toolbox appears over the Map window.
Select either Existing Route or Model Route from the Classify drop-down menu.
Click Create. COR processes the Blockface layer, which displays in the map.

Tag Route Values
Menu Procedure:
COR Menu Sidebar → Utilities → Tag Route Values
For the purpose of plotting maps, you can assign Existing Route values to Streets and
Blockfaces in your database. The route values are assigned to the streets based on the
address matched delivery records.

Procedure to Tag Route Values
1. In the sidebar, click Utilities to expand the menu item.
2. Click Tag Route Values. The Tag Route Values pop-up window displays. If you
wish to proceed, click Yes, and COR begins to tag route values in the current
zone.
3. At the end of the route tagging process, the pop-up window displays a route
tagging conflict report. (Note: If no delivery location layer or blockface layer has
been created, then an error message displays, stating "No delivery location
records were found."
4. To determine what the route tagging conflicts are, go to Open Street Table (Data
Preparation sidebar → Street and Office Procedures → Open Street Table) and
sort the table by the Route Tag Error column. Any street records where the
Route Tag Error field = Y will have 1 or more tagging conflicts.

43

COR DATABASE PREPARATION USERS MANUAL

Solution Manager
Menu Procedure:
COR Menu Sidebar → Utilities → Solution Manager
The Solution Manager allows you to save a version, or "snapshot" of the prepared data
in the current zone at any point in the data preparation process. Once the version is
saved, you may revert to it at any time, simply by returning to the Solution Manager and
selecting the version state, and loading it. The Solution Manager also provides you with
an effective way to back up your work.

Using Solution Manager
1. In the sidebar, click Utilities to expand the menu item.
2. Click Solution Manager. The Solution Manager window displays.
3. Click Save. The current state of the prepared data in the zone populates the
Solution Manager table, and the description column. Once the solution has been
saved, you may edit the name of the saved version in the description column..
4. To delete a solution, click the solution in the table and click Delete. Click OK to
confirm you want to delete the selected solution.
At any time you may reopen the Solution Manager and revert to an earlier saved state of
the zone. Select the state by clicking on it in the solution table, and clicking Load. The
current zone reverts to the selected state.
Note: You may only save up to five solutions per zone.

Change Route Color
Menu Procedure:
COR Menu Sidebar → Utilities → Change Route Color
All routes are color coded within COR. If it is necessary to change the color of a route
(for example, when two routes have similar colors and are very close to each other in the
map) use Change Route Color.

Procedure to Change Route Color
1. In the sidebar, click Utilities to expand the menu item.
2. Click Change Route Color. The Change Route Color pop-up window appears
over the Map window.
3. Select a route from the Route drop-down menu. The route's color appears in the
color swatch next to the drop-down menu.
4. Click Select. The color selector opens. In the color selector, choose a new color
for the route you selected, and click OK. The color swatch in the Change Route
Color window changes to the new color.
5. Click Apply. The route's color changes to the new color you selected.
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Chapter 12
Reports
NDSS by Street Name
Menu Procedure:
COR sidebar → Reports → NDSS by Street Name
NDSS by Street Name lists the AMS street name and address range that is associated
with every street Plus4 in the current zone. The entries in this report are ordered by
street name and address. For reference, you can create a printable list of all street
names sorted alphabetically, that are found in the NDSS file for the current ZIP Code.
1. In the sidebar, click Reports to expand the menu item.
2. Click NDS by Street Name. The NDS Report by Street Name displays in a new
browser window.
3. To print the report select Print from the File menu in the Internet Explorer tool bar.
4. To close the report, select File → Exit, or File → Close.

AAT Street Name Conflicts
Menu Procedure:
COR Menu Sidebar → Reports → AAT Street Name Conflicts
AAT Street Name Conflicts lists every blockface in the zone in which the associated nonCBU and non-central delivery type AAT records are assigned more than one street
name. For each blockface in the report, the street number, street name and delivery
location ID values of all the corresponding AAT records are listed. You should review
this report, to verify that each of the AAT records were properly address matched.
1. In the sidebar, click Reports to expand the menu item.
2. Click AAT Street Name Conflicts. The AAT Street Name report displays in a new
browser window.
3. To print the report select Print from the File menu in the Internet Explorer tool bar.
4. To close the report, select File → Exit, or File → Close.
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Manually Moved/Matched Deliveries
Menu Procedure:
COR sidebar → Reports → NDS by Street Name
Manually Moved/Matched Deliveries lists every delivery location in the zone that you
have manually moved or matched. The report entries represent all of the delivery
locations not placed in a location that was determined by the automatic address
matching procedure.
1. In the sidebar, click Reports to expand the menu item.
2. Click Manually Moved/Matched Deliveries. The Manually Moved Delivery Location
report displays in a new browser window.
3. To print the report select Print from the File menu in the Internet Explorer tool bar.
4. To close the report, select File → Exit, or File → Close.
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Chapter 13
COR to WebCOR Import
Menu Procedure:
COR sidebar → Utilities → COR to WebCOR Import
The directions below will appear.
Desktop COR 1.5 Menu Procedure:
COR Menu Bar → Tools → Export
How to package COR 1.5 Data for WebCOR
1.
2.
3.
4.

Load a Zone, in COR 1.5
Set the layer to Streets
Choose Tools\Export
The Export Streets Geography Window will appear

5.
6.
7.
8.
9.

Make sure Export shows All Features
Click the drop down arrow next to To and select ESRI Shape
Click OK
The Save As window will appear
Change the Look In to be
c:\program files\cor\map\XXXXX\db\ (where XXXXX is the 5-digit ZIP)
10. Set the File name to be XXXXXstr.shp
11. In the folder c:\program files\cor\map\xxxxx\db you will find 4 the files:
• XXXXXstr.trn
• XXXXXstr.dbf
• XXXXXstr.shp
• XXXXXstr.shx
12. Zip these files using WinZip and Upload the zip file by clicking the link below.

Upload Zone
You can check on the status of your zone by clicking on the link below.
Check Zone Import Status
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Chapter 14
Printing Maps
Menu Procedure:
Toolbar → Print Icon
The Print tool allows you to print your current Map display.
1. Click the Print icon. The Print Settings pop-up window appears over the Map window.
2. The Title is automatically set to your Zone. You may select the text and edit the title.
3. Create a Subtitle if necessary.
4. Click the Resolution dropdown arrow and choose the resolution you want for the map.
Higher resolution is better for printing large maps.
5. Click Create. A pdf will open once the Map is created.
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Appendix A
Street Class Definitions
Determine a template of the street classifications that you will use and consistently use
the same codes to represent the same types of streets for each zone that you work on.
NAVTEQ CLASS
1
2
3
4
5

CLASSIFICATION
Major highways
Major highways used to channel traffic to and from
CLASS 1 roads
Secondary highways, roads that interconnect CLASS 2
roads
Roads that provide high volume of traffic at moderate
speeds between neighborhoods
Residential roads

NOTE: You can add any number of additional Classes for other types of streets
such as School Zones or other streets that do not meet the current categories of
Classes.
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Appendix B
WebCOR On-Line Help Guide
Using the COR Help Guide This help guide is embedded within the COR system to
provide overview, reference and procedural instruction on each of the steps needed to
complete data preparation and route adjustment using COR.
The COR Help Guide provides context sensitive help so that relevant help topics display
when the Help Guide is accessed from different parts of the COR application. It also
provides you with keyword search, a comprehensive index, and a table of contents
listing all topics and tasks within COR.
What is COR? The COR application is a tool to enable the adjustment of letter carrier
route territory and the planning of efficient lines of travel. COR is based on a Geographic
Information System (GIS) and supports a user by enabling them to visually see the street
territory for a ZIP Code that is being adjusted.
Minimum System Requirements A reasonably equipped business computer running
Windows 98, 2000, XP or Vista; 512 MB RAM; Internet Explorer (IE) 6 or later with popup blocker disabled.
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Appendix C
Data Preparation Checklist

ZONE: __________

Data Preparation involves the collection, aggregation and preparation of data to support
the route adjustment process. Below is a checklist of tasks that must be performed to
prepare data for route adjustment.
Setting Up a Zone:

 1. SELECT A ZONE
To prepare data from an existing zone, go to the Zone Selection screen and enter a fivedigit ZIP Code in the Zone field.
Click Open Zone.
The COR Data Preparation screen appears, displaying your selected zone.

 2. EXTRACT A ZONE
In the Zone Selection screen, enter a five-digit ZIP code in the Zone field, then click
Extract Zone. The Data Preparation—Extract Zone screen appears, and the streets
whose ZIP Code matches the zone you selected are highlighted in the map, and the
Extract Zone pop-up window appears over the map.
In the Extract Zone pop-up window, you may rename the zone you are extracting, by
entering a new ZIP Code in the Zone field.
If you want to add to the zone, or remove an area of the zone, select the appropriate
radio button.
To add/remove areas of the zone, use either the Polyline Select, Rectangle Select, or
Polygon Select tool to select the area you want to add or remove.
After selecting areas in the map to add-to or remove from your zone, you can revert to
your original selected zone by clicking Reselect.
Click Zoom to zoom in to the selected zone.
Click Extract to extract the zone.

 3. DOIS IMPORT
Import from DOIS by clicking the Down Arrow under Utilities to expand the menu. Select
DOIS Import. A pop-up menu will appear asking whether you wish to Perform a DOIS
Import. Click Yes to Import from DOIS and No to Exit.
Preparing the Data:

 4. OPEN ALTERNATE ADDRESS TABLE
In the COR Menu Sidebar, click Delivery Location Procedures to expand the menu item.
Click Open Alternate Address Table. The Alternate Address Table pop-up window
displays.
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For more information see Open Alternate Address Table in the COR Data Preparation
section of the Help Guide.
Delivery Locations and Address Matching:

 5. EDIT THE AAT
Edit Alternate Address Table
Columns with editable information in the AAT have a white background; all other
columns are read-only with gray backgrounds. The editable columns are Delivery
Location Number, Delivery Location Street, and CBU BLDG. These are the fields that
allow you to create alternate addresses.
To make changes to one of these for a selected delivery address, click the field in the
appropriate column, and you may make changes as needed.
Edit CBUs
As you scroll down through the AAT, you will see in the CBU BLDG field some entries
with C and some with numbers. The C is an indication that the delivery point is part of an
CBU and must have further information set.
The entries with numbers are Central Box Units where the building number is the same
for all the addresses and the actual deliveries are all at one location. For the central
boxes, COR determines a unique CBU BLDG value. This will ensure that all these
deliveries are represented by a single delivery location.

 6. ADDRESS MATCH DELIVERY LOCATIONS
In the COR Menu Sidebar, click Delivery Location Procedures to expand the menu item.
Click Address Match Delivery Locations. The Address Match Delivery Locations pop-up
window appears over the map, and displays the number of matched and unmatched
delivery locations.
Click Match Locations, and COR automatically matches the unmatched delivery
locations in the current zone, and the Delivery Location Layer is visible in the map.
See Address Match Delivery Locations for more information.

 7. RESOLVE UNMATCHED DELIVERY LOCATION ADDRESSES
Delivery Location Toolbox
In the sidebar, click Delivery Location Procedures to expand the menu item.
Click Delivery Location Toolbox. The Delivery Location Toolbox appears over the map.
Click the Match Delivery Location tool

.

The Delivery Location Toolbox displays a summary table of unmatched delivery
locations.
Select an unmatched delivery location in the summary table by single-clicking on it. You
may locate the delivery location in the map using Selection Tools (Sidebar → Utilities →
Selection Tools).
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With the unmatched delivery location selected in the summary table, click the location in
the map where the delivery location belongs.
Now click the street on which you placed the delivery location. The unmatched delivery
location is matched to the location you selected.
See Delivery Location Toolbox for more information.
Blockfaces and Route Maps:

 8. CREATE BLOCKFACE LAYER
In the sidebar, click Utilities to expand the menu item.
Click Blockface Toolbox. The Blockface toolbox appears over the Map window. (note:
Change Classification and Model Route are not used in COR Data Preparation).
Click Create. COR processes the Blockface layer, which displays in the map (be sure to
have the Blockface layer visibility selected in Map Layers).
See Blockface Toolbox for more information.

 9. TAG EXISTING ROUTE NUMBERS
For the purpose of plotting maps, you can assign Existing Route values to Streets and
Blockfaces in your database. The route values are assigned to the streets based on the
address matched delivery records.
Tag Route Values
In the sidebar, click Utilities to expand the menu item.
Click Tag Route Values. The Tag Route Values pop-up window displays. If you wish to
proceed, click Yes, and COR begins to tag route values in the current zone.
At the end of the route tagging process, the pop-up window displays a route tagging
conflict report. (Note: If no deliver location layer or blockface layer has been created,
then an error message displays, stating "No delivery location records were found."
To determine what the route tagging conflicts are, go to Open Street Table (Data
Preparation sidebar → Street and Office Procedures → Open Street Table) and sort the
table by the RouteTag Error column. Any street records where the Route Tag Error field
= Y will have 1 or more tagging conflicts.

 10. FIELD VERIFY STREETS
Please refer to your USPS Field Verification Form.
Street Preparation

 11. UPDATE STREETS
In the sidebar, click Street and Office Procedures to expand the menu item.
Click Open Street Table. The Street Table displays over the map.
In the Street Table, all white fields are editable and all gray are not. You can sort the
data in the table by clicking any column header. Click the header a second time to
reverse the sort-order.
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Use the Street Table to resolve streets with incorrect ZIP Codes, incorrect or missing
address ranges, overlapping address ranges, incorrect street names and route codes,
and route tag errors.
See Open Street Table for more information.

12. EDIT ONE-WAY STREETS
Edit One-Way Streets
In the sidebar, click Street and Office Procedures to expand the menu item.
Click Edit Network Attributes. The Edit Network Attributes window appears over the Map
window.
To edit a one-way street, select One-way from the Layer drop-down menu.
One-way streets in the current zone appear in the map highlighted by a blue line and
black arrowheads, pointing in the direction of the one-way street as it is stored in the
Street layer (Note: It may be necessary to zoom in to see the displayed one-way
streets).
Select the Add tool . Click once on a section of the highlighted one-way street. The
highlighted blue line and arrowheads disappear, and the street is changed into a twoway street.
Click in the same section of the street a second time, and the highlight blue line and
arrowheads reappear, pointed in the opposite direction. The direction of the one-way
street has been changed. If you click a third time, the street is restored to its original
direction.
You may click a two way street to change it to a one-way street, using the same method.
See Edit Network Attributes for more information.

 13. EDIT OVERPASSES
Add Overpasses
In the sidebar, click Street and Office Procedures to expand the menu item.
Click Edit Network Attributes. The Edit Network Attributes window appears over the Map
window.
To add an overpass, select Overpass from the Layer drop-down menu.
Select a value of 1 to add an overpass, and -1 to add an underpass (the default value of
streets in the zone is 0; you may add 2 or -2 for overpasses and underpasses with more
than one level).
Select the Add tool , and click the street on which the overpass belongs, on one side
of the intersection. The number 1 is added to the map.
Click the street on the other side of the intersection, and a second 1 is added to the map,
indicating that the street you selected is elevated over the cross street and no turns can
be from it at the intersection.
Remove Overpasses
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In the sidebar, click Street and Office Procedures to expand the menu item.
Click Edit Network Attributes. The Edit Network Attributes window appears over the Map
window.
To remove an overpass, select Overpass from the Layer drop-down menu.
To remove the overpass, select the Remove tool
and click the numbers on either side
of the intersection. See Edit Network Attributes for more information.

 14. EDIT STREET ATTRIBUTE DEFAULTS
In the sidebar, click Street and Office Procedures to expand the menu item.
Click Street Attribute Defaults. The Street Attribute Defaults pop-up window appears
over the Map window. In the Drive Rate (MPH), Crossing Difficulty, and Parking
columns, enter new default values in the fields for street classes.
Click Save. Your changes are saved and the Street Attribute Defaults pop-up window
closes. See Street Attribute Defaults for more information.

 15. BUILD TRAVEL NETWORK
In the sidebar, click Street and Office Procedures to expand the menu item.
Click Build Travel Network. The Build Travel Network pop-up window appears over the
Map window. The Build Travel Network window displays information on when the travel
network was last built.
Click Yes to build the travel network, or No to exit without building it.
To display any network disconnectivities, click Street and Office Procedures and select
Display Network Disconnects. The Display Network Disconnects pop-up window
appears. Select the type of network disconnects to display, and click OK.

 16. SET TURN DEFAULTS
In the sidebar, click Street and Office Procedures to expand the menu item.
Click Edit Turn Defaults. The Edit Turn Defaults pop-up window appears over the Map
window.
In the Edit Turn Defaults pop-up window, edit the penalty values in seconds in the
Straight Through, Right Turn, Left Turn, and U-Turn fields (Note: While these penalties
can affect the actual path that the line of travel follows, the penalty time is not added to
the travel time.)
Click Save to exit the window.
Revise Address Matching (repeat the following steps):
Address Match
Create Blockface Layer
Tag Existing Route Numbers
Add Post Office
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Glossary
A
Address Match: The process of locating street addresses on a digital street map.
Alternate Address Table (AAT): A table of each individual delivery point. Alternative delivery location
addresses may be entered in the AAT to locate one or more deliveries at the location where the
mail is delivered.
Area Layer: A database layer containing boundary information for a two dimensional object like a parcel
of land or a ZIP Code zone.
Attribute: A distinguishing feature or characteristic of a geographic feature. For example some attributes
of a street segment are its name, address range, route id, etc.

B
Backup: Making a copy of a file or a whole disk for safe keeping in case the original is lost or damaged.
Blockface: A single side of a single street segment.
Buffer: The area or objects around an object such as the streets adjacent to a ZIP Code area.

C
CBU: Collection Box Unit
CDS File: ASCII file containing the CLASS records.
Coordinates: A set of numbers that specifies the location of a point either on a two-dimensional X-Y
plane, or in a three-dimensional X-Y-Z space.
Cursor: A movable marker that is used to indicate a position on the display screen.

D
Data: A value or a set of values that represents information.
Database: A collection of information that is systematically organized within an integrated structure.
DCD: Data Collection Device. A hand held computer used by USPS to capture route inspection data.
Default: Refers to the value that will be used or stored if one is not specified.
Delivery Data: Same as Route Inspection Data. Includes possible and observed deliveries, delivery time,
mode of delivery, delivery type, route id, and ZIP+4.
Delivery Location Layer: A layer that contains the actual letter carrier delivery locations. Deliveries in a
CBU are grouped together to form single delivery locations.
DPF: An alternative ASCII file to the CDS containing all the CLASS records.
DPS: Refers to the automated sorting equipment's capability to sort mail into route delivery sequence. This
mail is referred to as Delivery Point Sequenced mail.
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E
Element: One entry in the database. Also known as a Data Element.
ESRI: Environmental Systems Research Institute is responsible the GIS software utilized for WebCOR.

F
Feature: A geographic entity that occupies or is referenced to a specific location or area on the earth's
surface
Field: A location in the database that stores information associated with a data element of a geographic
feature.
File: A collection of related information in a computer that can be accessed by a unique name.

G
Geographic Coordinates: Coordinates specifying a point on the surface of the earth. See also
Coordinates.
Geographic Database: A database which integrates spatial and non-spatial attribute data for geographic
features.
GeoLimited: A Delivery Routing System deployed in the USPS for managing territory route adjustments.
GIS: Geographic Information System. A computer system used to collect, integrate, store, analyze,
retrieve, manipulate, and display geographic data.

H
Hardware: The physical components of a computer system - the computer, plotters, printers, display
screen, hard drives, mouse, etc.

I
Input: To enter data into a computer or the data entered into a computer.
Intersection: The point at which two or more streets cross on a map and street segments start or end.

L
Latitude: The distance on the Earth's surface north or south of the Equator measured in degrees. In COR
all Y coordinate values are stored in millionths of degrees north of the Equator.
Layer: A database storing one type of geographic feature. There are three types of layers: points, lines,
and areas. For example, Streets is a layer of lines that represent street segments, and ZIP Code
is a layer of areas that represent zone boundaries.
Line: One of the three basic geographical elements, defined by at least two pairs of X,Y coordinates called
nodes. Also known as an arc, link or segment.
Longitude: The distance on the Earth's surface east or west of Greenwich, England measured in degrees.
In COR all X coordinate values are stored in millionths of degrees west of Greenwich. These
values are always negative since the USA is west of Greenwich.
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M
Maptitude: The GIS software developed by Caliper Corporation and utilized in COR. This software
provides the ability to display and manipulate geographic data. It is not used in WebCOR.
Master Database: A large Streets database containing many zones.
Menu: A user friendly list of available commands from which a user can select any one command at a
time.
Mouse: A hand steered device used to enter data into a computer .

N
NDS File: An AMS file containing street segment and address range data for Plus4 values in a zone
Node: A point defining either end of a street segment.
Non-graphic Data: Attribute data which do not have intrinsic spatial characteristics. For example, delivery
time and observed deliveries.

O
Overlay: The process of stacking or layering digital representations of various spatial data on top of each
other so that all the information can be viewed and analyzed together.

P
Plot: A hard copy graphic representation of a drawing or map produced on a computer plotter or printer.
Plotter: A device used for converting digital maps into hardcopy output.
Polygon: A multi-sided figure used to represent the boundary of a ZIP Code zone.
Program: A precise sequential set of instructions directing the computer to perform a task.

Q
Query: The process of making a database inquiry.

R
Record: A set of attributes in a database describing a particular feature. For example, all the data in the
database for one street segment would be called a street record.
Route: A collection of street segments to be serviced by a letter carrier within one workday.

S
Scale: To change the representation of a quantity, expressing it in other units, so that its range is brought
within a manageable size. Also the ratio of a map to the real world.
Segment: A data record in the Streets layer. It holds all the data for one street segment.
Shape Point: A coordinate point used to define shape to a street segment between its end points
Software: A general name for computer programs and programming languages.
Symbol: A standardized graphical image representing a particular feature or class of features.
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T
Tagging: The process of entering the attribute information relating to the street segments in the database,
such as tagging the existing route values.
Theme: A representation of data using graphical elements such as color, shading, or symbols to provide
information about database elements. Its use is known as thematic mapping.
Topology: The way in which geographic features are related to each other in terms of adjacency,
connectivity, and containment. These relationships are automatically stored for each feature in the
COR databases. For the purpose of COR, topology refers to the direction in which streets were
drawn on the Map.
Travel Network: A snapshot of the street database used by the routing algorithms and containing street
topology, one-way street information and travel speeds.
Turn Defaults: A value in seconds for the movement through an intersection to influence the preference
for certain types of movement while in the vehicle.
Turn Exceptions: Intersection specific values in seconds to encourage or discourage turns. Turn
exceptions override turn defaults.

V
Value: The entry in one attribute field.

W
Window: A rectangular area on the computer’s screen. A window could contain a map display, attribute
tables, status message, DRS menu, or any other process.
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Layer Menu......................................................................10
Left Turn .....................................................................36, 60

M

B

Map .....................................................................................9
Measure ............................................................................10
Merge features ...................................................................30
Minimum System Requirements ....................................54
Missing or Incorrect Street Names ...................................25
Missing Streets ............................................................25, 27
modify the geography of a street .......................................27
Move vertex.......................................................................30
MPH .............................................................. See Drive Rate

buffer. ............................................................................... 14
Build Travel Network.................................................. 39, 60

C
CBU .....................................................20, 21, 32, 46, 57, 62
Central Delivery.......................................................... 20, 21
Change Zone.................................................................... 10
Class ........................................................................... 35, 52
Clear Feature(s)................................................................. 30
COR Menu Sidebar 9, 12, 16, 18, 20, 22, 24, 25, 27, 32, 37,
39, 40, 42, 44, 45, 46, 56, 57
Crossing Difficulty ........................................................... 35

N
navigational elements .........................................................9
NDCBU .................................................................. See CBU
NDSS records ....................................................................16
No Parking.........................................................................35

D
Data Access ........................................................................ 8
Data Access privileges........................................................ 9
Data Access Privileges........................................................ 9
Delete feature.................................................................... 30
Delete vertex..................................................................... 30
Delivery Location Procedures..............20, 24, 32, 33, 56, 57
Delivery Location Table ............................................. 24, 32
Discard Edit(s) .................................................................. 30
Disconnect Layers............................................................. 40
Display Network Disconnects................................... 40, 60
DOIS Import ..................................................................... 16
Drive Rate................................................................... 35, 60

O
Occurrence.........................................................................35
one-way street..................................................38, 39, 59, 65
Opening WebCOR...............................................................5
Overlapping Address Ranges ............................................25
overpasses..............................................................37, 38, 59

P
Pan ....................................................................................10
Penalty Value ....................................................................37
Pointer Tool.......................................................................14
Post Office is not within the zone ...................................14
Print ..................................................................................10

E
eAccess ............................................................................... 5
Edge .................................................................................. 28
Edit Information Tool............................................... 10, 11
Edit Streets .......................................................... 21, 27, 28
Editing street attributes ..................................................... 34
expand a menu item ......................................................... 9
Extents (Back) ................................................................. 10
Extents (Forward)........................................................... 10
Extract Zone................................................................ 14, 56

R
Re-Address Match .......................................................25, 26
Rectangle ...............................................................14, 22, 56
Redo ..................................................................................30
Remove tool ..........................................................37, 38, 60
Responsibilities and Privileges..........................................8
Right Turn ...................................................................36, 60
Role .....................................................................................8
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Tolerance .......................................................................... 28
Tool Icons ......................................................................... 11
turn defaults ................................................................ 36, 65
Turn Exceptions.......................................................... 37, 65

S
Save Edit icon ................................................................... 28
Save Edit(s) ....................................................................... 30
Select by Shape ........................................................... 14, 22
Select Feature .................................................................... 30
Selected Records ............................................. 25, 26, 32, 34
Selection Color.................................................................. 28
Selection tools ................................................................... 22
Settings........................................................................ 28, 30
Show Vertices ................................................................... 30
Snapping Tolerance........................................................... 28
split a street ....................................................................... 27
Split feature ....................................................................... 30
Straight Through ......................................................... 36, 60
Street and Office Procedures34, 35, 36, 37, 38, 39, 40, 42,
44, 58, 59, 60
street elevation .................................................................. 38
Street Layer ....................................................................... 28
Street Table ........................22, 25, 26, 27, 32, 34, 44, 58, 59
street validation ............................................................... 21

U
Undo ................................................................................. 30
unmatched records.................................................... 25, 26
U-Turn ........................................................................ 36, 60

V
vertex .......................................................................... 28, 30

W
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